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Irrigation Modernization and Design of Pipe 
Distribution Networks

PIPE SIZING AND INTRODUCTION TO EPANET FOR DESIGN 
OF PIPE SYSTEMS AND DESIGN EXERCISE 1 - SORRA
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Pipe Friction – Hazen Williams

𝑄𝑄 = 1.292 x 10−5 C D2.63 S0.54 

𝑄𝑄 = 1.292 x 10−5 C D2.63 S0.54 
 
Where: 
 
Q = discharge in cubic metre per hour 
D = diameter of pipe in mm  
V = velocity in m/s  
S = slope of hydraulic grade-line  
C = Hazen Williams coefficient (140-150 is suggested for plastic and GRP pipes). 

Adopting 140 is 
conservative for 

fuse-weld 
connected HDPE 

pipes

Presenter Notes
Presentation Notes
Hazen Williams with roughness coefficient C; Darcy Weisbach with friction factor, f, Chezy Manning with manning coefficient, n
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Velocity Limits
• Maximum operating velocity is limited by 

water hammer and/ or surge pressure 
considerations. Suggest:
– HDP Pipe: 2.0 m/s (2.5 m/s)
– uPVC Pipe: 1.5 m/s (1.7 m/s)

• Minimum velocity to be 0.3 m/s (0.5 m/s) to 
avoid sediment deposition in pipes. Coarse 
sediment and trash should not be allowed to 
enter the pipe system by using screens and 
sediment chamber as required.
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Head requirements at Field 
Hydrants 
• For surface irrigation: 0.5 - 2.0 m
• For pressure irrigation: 

– Drip: 15 – 20 m
– Sprinkler system:

• Low head of 5-20m giving throw radius of 2-4 m
• Medium head of 20-50 m giving throw radius of 3-7 m
• High head of 50 – 100 m giving throw radius of 6-19 m

– For smallholder sprinkler irrigation pressures of 
20-30 m are suitable. 
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Losses Due to Bends, Transitions, Fittings 
and Valves
Head loss = C V2/2g (where V is in m/s)
Loss coefficient C values:
• Bends:

0.15 (22.50) ; 0.30 (450) ; 0.75 (900)
• Entry to a pipe: 0.50 (sharp); 0.05 (bell).
• Branch: 0.10 (straight); 0.90 (branch)
• T-pipe: 0.40
• Gate valve (fully open): 0.2
• Globe valve (fully open): 6.0-7.0
• Water meter: 7.0
• Alfalfa valve (fully open): 1.5 to 2.0
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Design Exercise #1: Design 
of Pipe System for Sorra
(Loharu, Haryana)
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Design Exercise #1: Design of Pipe 
System for Sorra (Loharu, Haryana)
• Stage 1: Initial Settings
• Stage 2: Backdrop Map, Command Area and 

indictive Layout (google earth)
• Stage 3: Layout (EPANET)
• Stage 4: Assign data to junctions and pipes
• Stage 5: Run program and optimise design by 

adjusting pipe sizes
• Stage 6: Generate tables, save to excel, and 

estimate cost for pipe system
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Stage 1: Initial Settings
o Set the Dimensioning of the map: View > Dimensions 

… > Map Units > Meters > Ok.
o Set the parameters within Epanet: 
 Project > Analysis Options… > Select the 

Parameters to change:
• Flow Units = LPS
•Head loss Formula = H-W

 Project>defaults
• Set 140 for pipe roughness
• Set pipe diameters at (say) 200 mm
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Stage 2: Backdrop Map, Command Area & Indicative 
Layout
o Delineate command area and decide on indicative 

layout for pipelines to connect hub-hydrants. Adopt:
o Design duty: 0.79 l/s/ha, CCA: 310 ha, Design flow: 244 l/s
o 1 field hydrant per 1.5 ha (i.e., one per farmer)
o 1 hub-hydrant per 4 farmers (~6.1 ha)
o Total number of hub-hydrants: ~51

o Google earth image saved as .jpeg file needs to be converted 
to .bmp file to load as backdrop map into EPANET (e.g., use 
“paint”, or pdf24 file converter). View > Backdrop > Load… > 
Select *.bmp file 

o Set scale by setting distance for length and breadth of image 
(measure distance on google earth). View>Dimensions
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Draw Command Area 
Boundary

Pump Pt: 28.603°, 75.684°
Pt 1: 28.6024°, 75.6777°
Pt 2: 28.6214°, 75.6754°
Pt 3: 28.6149°, 75.6946°
Pt 4: 28.6009°, 75.6937°

GCA 344 ha
CCA  310 ha
Duty 0.79 l/s/ha
Flow 244 l/s
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Prepare Indicative 
Pipeline Layout 
(google earth)

CCA  310 ha, Duty 
0.79 l/s/ha, Flow 244 
l/s

Land holding: 1.5 ha
No of FHs: ~206
No of DHs: ~51 
Flow to each DH : 4.8 
l/s (6.1 ha)

Save Image

Scale to AOI Box: 
Length = 2,392 m 
Height = 2,396 m
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Stage 3: Layout using EPANET (for pipelines to supply hub-
hydrants)

o Locate the Outlets (~ 51 No) evenly over the command 
area
o Field hydrant – 1 per farmer plot (say 1 per 1.5 ha)
o Hub-hydrants (also known as Outlets or Distribution Hubs) to 

supply groups of (say) 4 field hydrants.
o For turnout from canal or pumping station from river/ 

canal/ reservoir, select “reservoir”. 
o Connect hub-hydrants by pipelines. Make sure auto-

length is on (see bottom left - right click). 
o To move image, click: view-pan
o To display hydrant (junction) numbers and other 

information: view>options>
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EPAnet Symbols and Functions 

 

Click this (node) button to draw junctions onto your drawing. Junctions are used to 
indicate the demand within a system (see step 11).  

 

The reservoir button allows you to insert a reservoir. Make sure that you in the 
characteristics s box provide sufficient Head.  

 

Click this (link) button to draw pipes (connection Junctions) into your design. Make 
sure to rightfully fill out the characteristics box for each pipe (diameter, roughness, 
etc. (step 10).   

 
Click this button if you want to insert a pump. However in the initial phase when 
the aim is to calculate pipe sizes, a reservoir providing enough head should do.  

 

Click this (node) button if you want to add specific valves (non check valves) into 
your PIN.  

 

Click this button to run your design and see whether the systems is flawless.  

 

Click this button after running the analysis. It will provide an overview of your 
system. There are two main options: (1) Graphing nodes (junctions, pressure 
heads(m))  or (2) links  (Pipes; Flow rates (lps), Unit headloss (m/km)).  
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One possible 
layout shown here. 
Others possible.

310 ha
244 l/s
51 Outlets each 
4.8 l/s

Ring layout with hub- and 
field hydrants with high level 
of service (one connection 
for each farmer, irrigator 

flows up to 4.8 l/s by rotation 
from Outlets, 20 m pressure 
head enabling sprinkler or 

drip irrigation)
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Stage 4: Assign data to junctions and pipes
Select window, browser, data then:
• Allocate flows (4.79 l/s) to junctions (Outlets), also 

elevation head (** m) . Adopt 0.79 l/s/ha. Gives ~4.8 l/s 
for group of 4 hydrants, 6.07 ha, and 244 l/s for 310 ha)

• Allocate pipe diameters (first trial) to pipelines
• Check reservoir: net inflow should balance flows for 

junctions. Allocate a head, ** m

Display legends: in browser (>windows, >browser), select 
map, and chose parameters to display. Also set with map 
options (>View>options)
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Stage 5: Run program and optimise design by 
adjusting pipe sizes
o Run the program: Project> run analysis. 
o Adjust pipe diameters so that pressures and flows 

velocities are OK.
o Flows in range of 1.5-2.0 m/s (< 2.5 m/s) 
o Pressures within pipe class rating (or change pipe class).
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Stage 6: Generate tables, save to excel, and estimate 
cost for pipe system
o Generate tables of results: click Report> table, and 

select what columns / data for:
o Tables for links
o Tables for nodes

o To copy tables of results to excel, highlight data, and 
then click: EDIT, COPY TO CLIPBOARD, enter excel 
and PASTE.
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Network Table - Links

                        Length          Diameter        Roughness       Flow            Velocity        
Unit 

Headloss   
Friction 
Factor Rate Cost

 Link ID                m               mm                              LPS             m/s             m/km                            $/m $
Pipe 1                  194 355 140 115.20 1.16 3.21 0.016 54.3 10,530
Pipe 2                  317 250 140 60.86 1.24 5.43 0.017 27.1 8,604
Pipe 3                  263 250 140 56.06 1.14 4.66 0.018 27.1 7,152
Pipe 4                  316 180 140 23.19 0.91 4.5 0.019 14.1 4,467
Pipe 5                  260 140 140 18.39 1.19 9.97 0.019 8.6 2,226
Pipe 6                  265 125 140 13.59 1.11 9.89 0.02 6.9 1,831
Pipe 7                  192 125 140 8.79 0.72 4.41 0.021 6.9 1,327
Pipe 8                  175 125 140 3.99 0.33 1.02 0.024 6.9 1,205
Pipe 9                  155 125 140 -0.81 0.07 0.05 0.03 6.9 1,070
Pipe 10                 248 125 140 1.08 0.09 0.09 0.029 6.9 1,713
Pipe 11                 211 125 140 -3.72 0.30 0.9 0.024 6.9 1,453
Pipe 12                 221 125 140 -8.52 0.69 4.17 0.021 6.9 1,525
Pipe 13                 268 140 140 -13.32 0.87 5.49 0.02 8.6 2,291
Pipe 14                 281 160 140 -18.12 0.90 5.06 0.02 11.2 3,153
Pipe 15                 200 160 140 -22.92 1.14 7.82 0.019 11.2 2,238
Pipe 16                 189 160 140 2.61 0.13 0.14 0.026 11.2 2,115
Pipe 17                 177 180 140 -23.27 0.91 4.53 0.019 14.1 2,494
Pipe 18                 209 180 140 -28.07 1.10 6.41 0.019 14.1 2,959
Pipe 19                 243 160 140 21.08 1.05 6.7 0.019 11.2 2,721
Pipe 20                 257 140 140 16.28 1.06 7.96 0.02 8.6 2,198
Pipe 21                 180 125 140 11.48 0.94 7.24 0.02 6.9 1,245
Pipe 22                 203 125 140 6.68 0.54 2.66 0.022 6.9 1,404
Pipe 23                 296 250 140 49.54 1.01 3.71 0.018 27.1 8,031
Pipe 24                 159 225 140 44.74 1.13 5.13 0.018 21.9 3,484
Pipe 26                 227 200 140 30.34 0.97 4.43 0.019 17.3 3,923
Pipe 27                 249 355 140 124.80 1.26 3.72 0.016 54.3 13,506
Pipe 28                 292 225 140 40.34 1.01 4.23 0.018 21.9 6,405
Pipe 29                 313 200 140 35.54 1.13 5.94 0.018 17.3 5,413
Pipe 30                 249 180 140 30.74 1.21 7.59 0.018 14.1 3,514
Pipe 31                 264 160 140 15.57 0.77 3.82 0.02 11.2 2,962
Pipe 32                 157 140 140 10.77 0.70 3.7 0.021 8.6 1,346
Pipe 33                 156 125 140 5.97 0.49 2.15 0.022 6.9 1,074
Pipe 34                 213 125 140 1.17 0.10 0.1 0.028 6.9 1,469
Pipe 35                 187 125 140 -3.63 0.30 0.86 0.024 6.9 1,291
Pipe 36                 182 125 140 1.39 0.11 0.15 0.028 6.9 1,255
Pipe 37                 150 125 140 -3.41 0.28 0.76 0.024 6.9 1,037
Pipe 38                 185 140 140 -8.21 0.53 2.24 0.022 8.6 1,585
Pipe 39                 176 160 140 -13.01 0.65 2.74 0.021 11.2 1,975
Pipe 40                 250 180 140 -12.17 0.48 1.36 0.021 14.1 3,530
Pipe 41                 199 180 140 -16.97 0.67 2.53 0.02 14.1 2,817
Pipe 42                 177 180 140 -21.77 0.86 4.01 0.019 14.1 2,500
Pipe 43                 161 180 140 -26.57 1.04 5.79 0.019 14.1 2,272
Pipe 44                 292 180 140 -31.37 1.23 7.88 0.018 14.1 4,129
Pipe 45                 214 280 140 -36.17 0.59 1.19 0.019 33.8 7,228
Pipe 46                 258 315 140 -79.66 1.02 2.9 0.017 41.0 10,564
Pipe 47                 271 225 140 38.69 0.97 3.92 0.018 21.9 5,936
Pipe 48                 264 200 140 33.89 1.08 5.44 0.018 17.3 4,555
Pipe 49                 160 180 140 29.09 1.14 6.85 0.019 14.1 2,259
Pipe 50                 207 180 140 24.29 0.95 4.91 0.019 14.1 2,926
Pipe 51                 214 160 140 14.63 0.73 3.4 0.02 11.2 2,402
Pipe 52                 221 140 140 9.83 0.64 3.12 0.021 8.6 1,892
Pipe 53                 190 160 140 -5.64 0.28 0.58 0.023 11.2 2,124
Pipe 54                 179 160 140 -10.44 0.52 1.82 0.021 11.2 2,002
Pipe 55                 196 160 140 -5.57 0.28 0.57 0.023 11.2 2,195
Pipe 56                 142 160 140 -10.37 0.52 1.8 0.021 11.2 1,596
Pipe 57                 211 225 140 39.94 1.00 4.16 0.018 21.9 4,626
Pipe 58                 219 200 140 35.14 1.12 5.82 0.018 17.3 3,776

12,503 m 0.78 193,522
310 ha 1.26 310

40 m/ha 0.07 625

Network Table - Nodes
                        Elevation       Demand          Head            Pressure        
 Node ID                m               LPS             m               m               
Junc 1                  160 4.8 179.38 19.38
Junc 2                  160 4.8 178.28 18.28
Junc 3                  160 4.8 174.31 14.31
Junc 4                  160 4.8 172.75 12.75
Junc 5                  160 4.8 168.94 8.94
Junc 6                  160 4.8 168.75 8.75
Junc 7                  160 4.8 168.77 8.77
Junc 8                  160 4.8 168.94 8.94
Junc 9                  160 4.8 176.43 16.43
Junc 10                 160 4.8 174.29 14.29
Junc 11                 160 4.8 172.16 12.16
Junc 12                 160 4.8 172.39 12.39
Junc 13                 160 4.8 172.3 12.30
Junc 14                 160 4.8 173.72 13.72
Junc 15                 160 4.8 173.29 13.29
Junc 16                 160 4.8 174.09 14.09
Junc 17                 160 4.8 173.63 13.63
Junc 18                 160 4.8 174.13 14.13
Junc 19                 160 4.8 178.07 18.07
Junc 20                 160 4.8 178.33 18.33
Junc 21                 160 4.8 175.83 15.83
Junc 22                 160 4.8 179.07 19.07
Junc 23                 160 4.8 177.84 17.84
Junc 24                 160 4.8 175.98 15.98
Junc 25                 160 4.8 173.08 13.08
Junc 26                 160 4.8 172.14 12.14
Junc 27                 160 4.8 172.99 12.99
Junc 28                 160 4.8 172.8 12.80
Junc 29                 160 4.8 175.77 15.77
Junc 30                 160 4.8 177.27 17.27
Junc 31                 160 4.8 172.27 12.27
Junc 32                 160 4.8 173.4 13.40
Junc 33                 160 4.8 173.83 13.83
Junc 34                 160 4.8 177.66 17.66
Junc 35                 160 4.8 175.01 15.01
Junc 36                 160 4.8 172.41 12.41
Junc 37                 160 4.8 169.79 9.79
Junc 38                 160 4.8 168.76 8.76
Junc 39                 160 4.8 169.31 9.31
Junc 40                 160 4.8 170.62 10.62
Junc 41                 160 4.8 172.66 12.66
Junc 42                 160 4.8 169.86 9.86
Junc 43                 160 4.8 171.33 11.33
Junc 44                 160 4.8 175.32 15.32
Junc 45                 160 4.8 176.59 16.59
Junc 46                 160 4.8 177.47 17.47
Junc 47                 160 4.8 175.09 15.09
Junc 48                 160 4.8 174.74 14.74
Junc 49                 160 4.8 174.84 14.84
Junc 50                 160 4.8 172.5 12.50
Resvr 51                180 -240 180 0.00

Avg. 13.78
Max 19.38
Min 8.75

Results

310 ha
12,503 m of pipe
40.4 m/ha

$ 193,522 
$ 625/ ha


	Slide Number 1
	Pipe Friction – Hazen Williams
	Velocity Limits
	Head requirements at Field Hydrants 
	Losses Due to Bends, Transitions, Fittings and Valves
	Design Exercise #1: Design of Pipe System for Sorra (Loharu, Haryana)
	Design Exercise #1: Design of Pipe System for Sorra (Loharu, Haryana)
	Slide Number 8
	Slide Number 9
	Slide Number 10
	Slide Number 11
	Slide Number 12
	Slide Number 13
	Slide Number 14
	Slide Number 15
	Slide Number 16
	Slide Number 17
	Slide Number 18
	Slide Number 19

